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Introdução 

A Análise de Dispersão e Vicariância (DIVA, Dispersal and Vicariance Analysis) é um dos métodos conhecidos 

como "baseados em eventos" para reconstrução de história biogeográfica, nos quais os processos biogeográficos que 

ajudam a levar à especiação são incorporados a priori na metodologia (Ronquist 1996, 1997; Sanmartín et al. 2001, 

Ronquist & Sanmartín 2011). 

O programa DIVA estima a distribuição de ancestrais hipotéticos nos nós internos em uma árvore 

completamente bifurcada baseando-se na distribuição dos táxons terminais (Ronquist 1996). Isso significa que é 

possível usar o DIVA para inferir a biogeografia de um táxon mesmo quando um cladograma geral de áreas não está 

disponível. Resumidamente, o DIVA minimiza extinções e dispersões e assume vicariância como a hipótese nula 

(Ronquist 1996). Resultados de uma análise empregando o DIVA são distribuições ancestrais otimizadas em cada nó 

interno de uma filogenia, seguindo o critério da parcimônia. A reconstrução ótima das distribuições ancestrais é obtida 

por meio da otimização de uma matriz de custos tridimensional que se baseia nas seguintes simples regras: 

1. Especiação é assumida como originada a partir de vicariância separando uma distribuição originalmente ampla em 

dois conjuntos de áreas mutuamente exclusivos. Esse evento não possui custos na matriz (custo 0). 

2. Uma espécie que ocorre em uma única área pode sofrer especiação dentro da área alopatridamente 

(microalopatridamente ou possivelmente simpatridamente) originando dois descendentes que ocorrem na mesma área. 

Esse evento não possui custos na matriz (custo 0). 

3. Eventos de dispersão custam 1 por unidade de área adicionada à distribuição. 

4. Eventos de extinção local custam 1 por unidade de área deletada da distribuição. 

Incertezas nos resultados de DIVA são provenientes de duas fontes: incertezas filogenéticas (e.g. politomias) e 

incertezas na otimização do DIVA (e.g., como interpretar áreas ancestrais diferentes que foram reconstruídas como 

igualmente parcimoniosas?). Na tentativa de contornar essas incertezas, uma série de autores elaboraram 

complementos ao programa DIVA, tais como o Bayes-DIVA, proposto por Nylander et al. (2008), Bayes-DIVA, 

modificado de Harris & Xiang (2009), S-DIVA, proposto por Yu et al. (2010), entre outros. Todas as peculiaridades de 

cada tipo de alteração proposta ao DIVA original estão implementadas no programa computacional RASP - Reconstruct 

Ancestral State in Phylogenies (Yu et al. 2015). O programa é gratuito e disponível para todas as plataformas 

(WINDOWS/ MAC/ LINUX), além de possuir uma interface gráfica de fácil utilização. Por essas razões, esse é o 
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programa que empregaremos na atividade de hoje. Maiores detalhes sobre o programa podem ser encontrados no sítio: 

http://mnh.scu.edu.cn/soft/blog/RASP/. 

Para o desenvolvimento do exercício, utilizaremos dados provenientes do trabalho de Perret et al. (2006), que 

foram traduzidos, modificados e inseridos nesse tutorial para fins didáticos. É importante ressaltar que o foco dessa 

atividade não é o uso do programa propriamente dito, mas sim a interpretação dos padrões reconstruídos. 

 

Apresentação 

A Mata Atlântica brasileira é conhecida pelas altas taxas de riqueza em espécies e de endemismo, bem como 

por ser uma das florestas tropicais mais diversificadas e mais ameaçadas do mundo. Em sua definição ampla, o 

Domínio da Mata Atlântica abrange tipos variados de vegetação, inclusive alguns não-florestais (e.g., campos de 

altitude, dunas). Todavia, os dois tipos vegetacionais de maior extensão são a floresta pluvial costeira, que margeia a 

linha costeira do sul ao nordeste do Brasil, e a floresta semidecidual que se estende para o interior do Brasil, sobretudo 

no Sudeste e Sul, com pequenas porções adentrando o Paraguai e a Argentina. Embora existam muitas informações 

acerca da caracterização, flora e ecologia da Mata Atlântica, pouco se sabe sobre sua história biogeográfica. Afinidades 

entre as diferentes unidades fitogeográficas que compõem a Mata Atlântica e suas relações com outras áreas na 

América do Sul geralmente se baseiam em dados florísticos, padrões de distribuição e evidências paleoambientais. 

Estudos florísticos indicam uma forte ligação entre a Mata Atlântica costeira e as florestas semideciduais adjacentes 

das mesmas latitudes, ao passo que a comparação de trechos da mata costeira do nordeste com os do sudeste e sul 

mostre similaridade florística bem menor. Em uma escala mais ampla, foi evidenciada a relação entre as florestas 

semideciduais do Brasil e Paraguai e outros fragmentos esparsos de florestas tropicais sazonais ao longo de um grande 

arco peri-Amazônico que se estende do nordeste do Brasil, pela bacia dos rios Paraná e Paraguai, pelos Andes até o 

norte da América do Sul. Outra evidência baseada na distribuição de espécies proximamente aparentadas indica 

intercâmbios bióticos pretéritos entre Mata Atlântica e entre Andes ou Escudo das Guianas. Entretanto, pouco se 

conhece sobre a origem e eventos históricos de ampliação ou contração da distribuição da maioria dos grupos 

taxonômicos da Mata Atlântica. Também não é claro de que modo vicariância e dispersão atuaram para determinar as 

distribuições atuais. 

A tribo Sinningieae (Gesneriaceae, Angiospermae) é um grupo de plantas muito adequado para investigar os 

padrões gerais de biogeografia histórica da Mata Atlântica brasileira e suas relações com outras áreas na América do 

Sul. A maioria dos táxons de Sinningieae é encontrada em cadeias de montanhas na Mata Atlântica brasileira ou em 

áreas adjacentes ocupadas por tipos vegetacionais sazonais, i.e., no domínio das caatingas do leste e nordeste do 

Brasil, no domínio do cerrado no Brasil central, e no "Núcleo Missiones" na bacia dos rios Paraguai e Paraná. Um 

número restrito de espécies é também encontrada em regiões mais distantes, especificamente, nos Andes, na 

Amazônia, norte da Colômbia, Venezuela e sul do México. As plantas são principalmente saxícolas (ou rupícolas), mas 

algumas espécies são epífitas ou terrestres. São plantas frequentemente herbáceas com um tubérculo perene, folhas 

geralmente (sub)carnosas; apresentam flores tubulosas, vistosas e altamente nectaríferas, usualmente polinizadas por 

beija-flores, abelhas, morcegos ou mariposas; os frutos em sua maioria são cápsulas dotadas de pequenas sementes, 

possivelmente dispersas por "água de chuva" (Figura 1). 

http://mnh.scu.edu.cn/soft/blog/RASP/
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A filogenia apresentada por Perret et al. (2006) incluiu quase todas as espécies da tribo e foi obtida a partir da 

análise de sete partições de dados moleculares (Figura 2). Sinningieae foi recuperada como grupo monofilético, mas os 

tradicionais gêneros Vanhouttea e Paliavana são polifiléticos e estão inseridos em Sinningia. Os táxons estão 

distribuídos em três grandes clados (Dircaea, Corytholoma e Sinningia), além de em dois clados menores (Vanhouttea 

e Thamnoligeria). 

A partir de detalhados dados sobre a distribuição geográfica das espécies de Sinningieae, Perret et al. (2006) 

delimitaram 12 áreas biogeográficas: (A) os Pampas; (B) a porção sul da Mata Atlântica, ao sul do Trópico de 

Capricórnio; (C) a porção norte da Mata Atlântica, ao norte do Trópico de Capricórnio; (D) a região florística do Paraná 

(sensu Cabrera e Willink 1973), incluindo as florestas semideciduais da bacia do rio Paraná e Paraguai no leste do 

Paraguai, nordeste da Argentina e sudoeste do Mato Grosso do Sul (núcleo Missiones) e a Mata de Araucárias do 

sudeste do Brasil; (E) o Cerrado; (F) a região do São Francisco (província das caatingas sensu Prado 2000), incluindo 

as florestas semideciduais e os campos rupestres distribuídos a leste do rio São Francisco no Brasil e as caatingas do 

nordeste brasileiro; (G) o Chaco; (H) a porção sul dos Andes; (I) a porção norte dos Andes; (J) a Amazônia; (K) região 

norte da Colômbia e Venezuela e Escudo Guiano; e (L) América Central e sul do México (Figura 3). 

 

Objetivos da atividade 

Utilizando a filogenia anteriormente mencionada e os dados de distribuição das espécies de Sinningieae, 

faremos a reconstrução da história biogeográfica da tribo por meio do método de "Análise de Dispersão e Vicariância 

Estatística" (S-DIVA). Os objetivos dessa atividade são: 

1) Reconstruir as áreas de distribuição ancestral da tribo e de clados particulares; 

2) Inferir as direções e frequência de eventos de dispersão/vicariância; 

3) Avaliar a intensidade e o modo como os processos de vicariância e dispersão entre áreas atuaram durante a 

diversificação de Sinningieae. 

 

Preparação 

A. Para iniciar o estudo necessitaremos de: 

(1) Árvore filogenética do grupo de estudo: o arquivo com a árvore filogenética (ou árvores) deve ser obtido por meio de 

outros programas, tais como PAUP, MrBayes, BEAST. Aqui, já está sendo fornecido pronto (arquivo Tree.tre). Para ser 

lido pelo RASP, o arquivo deve seguir a estrutura NEXUS e deve conter a lista dos táxons e a filogenia em notação 

parentética. 

(2) Distribuição das espécies: os dados de distribuição poderiam ser inseridos no próprio programa (é bem simples!), 

mas já estão sendo fornecidos prontos (arquivo Distribution.csv). Especificamente, o arquivo contém uma lista de todas 

as espécies presentes na filogenia e as áreas biogeográficas em que elas ocorrem. 
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B. Iniciando o RASP 

(1) Inicialize o programa. 

(2) Selecione File> Load Trees> Load Trees (More Format) para encontrar e carregar o arquivo Tree.tre. O 

RASP carregará o arquivo e, quando tiver terminado, indicará na parte inferior da tela: 

Using tree: 
[a árvore em notação parentética] 
Load Condensed Tree Successfully! 
Loading Trees Dataset... 
Load Trees Dataset Successfully! 

Na parte superior da tela do programa será possível visualizar os nomes dos 76 táxons de Sinningieae além do 

nome do grupo-externo, Nematanthus villosus (coluna Taxon). Na coluna Select, selecione esse nome como grupo-

externo. 

Note que na porção direita da tela do programa (Tree Option), o programa automaticamente selecionou 

Current Condensed Tree. Se ao invés de utilizar apenas uma árvore, tivéssemos carregado um conjunto de 

árvores, deveríamos obter uma árvore de consenso (condensed tree) no próprio RASP. 

(3) Selecione File> Load Distribution para encontrar e carregar o arquivo Distribution.csv. O RASP carregará o 

arquivo e, quando tiver terminado, indicará na parte inferior da tela: Load Distributions Successfully! 

Além disso, na parte superior da tela do programa será possível visualizar as áreas biogeográficas em que 

ocorrem cada táxon (coluna Distribution). 

 

Análise de Dispersão e Vicariância 

(1) Selecione Analysis> Statistical Dispersal Vicariance Analysis para iniciar a análise. Uma nova janela 

(Range) se abrirá. Não há necessidade de alterar nesse momento nenhum dos parâmetros presentes nessa tela; 

deixe tudo como está e clique em OK. 

Em seguida, a janela Range sumirá e você será levado de volta à janela RASP. Quando a análise tiver 

encerrado, aparecerá na parte inferior da tela: 

Analysis end at MM/DD/AAAA HH:MM:SS 

(2) Selecione Graphic> Tree View para visualizar o resultado. Uma nova janela (S-DIVA Analysis Result) se 

abrirá. 

(3) Selecione View> Option para alterar elementos gráficos, tais como tamanho da árvore, tamanho de fonte, 

comprimento dos ramos... Uma nova janela se abrirá (Option). Vários itens podem ser alterados, mas no momento, 

para facilitar a visualização na tela, faça o seguinte: 

 a. Na seção Labels, selecione Node distribution, para que o programa indique as letras correspondentes 

às áreas reconstruídas para os nós. 

 b. Na seção Tree, altere o valor para 15 em Taxon separation, e para 40 em Branch length. Dessa 

forma, a figura não fica muito grande. 
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 c. Clique em OK para encerrar as alterações. 

(4) Se quiser salvar a árvore como figura, selecione File> Export graphic> Export tree e indique em qual formato 

você quer salvar a árvore (para o nosso exercício, selecione PNG Files). Depois de escolher um nome e clicar em 

Save, uma pequena janela aparecerá, indicando que o arquivo foi salvo (Save Successfully!). Alternativamente, 

você pode salvar no formato .svg. 

(5) Na janela S-DIVA Analysis Result, observe a imagem mostrando a topologia com as áreas ancestrais 

otimizadas. Os gráficos em pizza representam a probabilidade de distribuições ancestrais em cada nó; em alguns 

casos, a otimização resulta em hipóteses alternativas de distribuição ancestral (e.g. node 84). Para visualizar um nó 

em particular, na porção esquerda superior da tela, na aba List, selecione a linha que indica o nó desejado e note que 

esse mesmo nó será evidenciado na figura (um círculo vermelho circundará o gráfico em pizza). Faça isso com o node 

84 e veja que para esse nó a reconstrução da área de distribuição ancestral resultou em duas hipóteses alternativas 

(área BF e área F). Em alguns nós, a reconstrução da área de distribuição ancestral é ambígua (indicada pela cor preta; 

e.g., node 115). 

(6) A visualização das reconstruções na tela pode não ser tão fácil, por isso a figura com resultados está sendo 

fornecida ao final desse protocolo. Confira se o resultado que você obteve é igual à figura fornecida (deveria ser!). 

(7) Agora, vamos analisar os resultados! 

 a. Indique as áreas reconstruídas como áreas de distribuição ancestral para cada um dos seguintes clados 

(olhe a legenda da Figura 3 para saber a que áreas se referem as letras): 

Clado Área de distribuição ancestral 

Sinningieae  

(node 152) 

 

Vanhouttea + Dircaea + Corytholoma + Sinningia 

(node 149) 

 
 
 

Dircaea + Corytholoma + Sinningia  

(node 145) 

 
 
 

Corytholoma + Sinningia  

(node 144) 

 
 
 

Dircaea  

(node 103) 

 
 
 

Corytholoma  

(node 125) 

 
 
 

Sinningia  

(node 143) 

 
 
 

 

 b. Para os clados designados abaixo, descreva entre quais áreas os eventos de dispersão-vicariância foram 

mais frequentes. 
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Clado Entre quais áreas os eventos foram mais frequentes? 

Thamnoligeria 

(node 151) 

 

 

Vanhouttea 

(node 148) 

 

Dircaea 

(node 103) 

 

 

 

Corytholoma 

(node 125) 

 

 

 

Sinningia 

(node 143) 

 

 

 

 c. Quanto à direção dos eventos, o que foi mais comum, movimentos da costa para o interior ou do interior 

para a costa? Você acha que esses movimentos devem ter sucedido como mecanismos de DIFUSÃO (expansões 

graduais de área de distribuição acompanhando ampliação do habitat decorrente de alterações climáticas, ou 

colonizações ponto a ponto de áreas favoráveis próximas) ou de DISPERSÃO (a longa distância). Por quê? Como 

tentar corroborar uma ou outra possibilidade? Você lembra de hipóteses de eventos similares a estes, que foram 

estudadas em artigos mais recentes nas aulas e GDs anteriores? Cite exemplos. 

 

 

 

 

 

 

 d. As espécies mais amplamente distribuídas (i.e. com ocorrência no Chaco, Pampas, Andes, Amazônia, Norte 

da América do Sul e América Central) estão agrupadas nos clados 1 e 2 de Corytholoma (Figura 2). Em particular, há 

quatro espécies de Sinningieae que ocorrem também nos Andes (H e I): Sinningia sellowi, S. warmingii, S. incarnata e 

S. elatior. Localize-as na figura obtida com o S-DIVA. Agora, examine os pontos de ocorrência de cada uma dessas 

espécies (Figura 4). Note que tais espécies são também encontradas na região do Paraná (D), região do São Francisco 

(F), ou em ambas. Essas espécies apresentam distribuições perfeitamente contínuas, ou estão distribuídas de modo 

disjunto? Qual a relevância deste aspecto para inferência da história biogeográfica desses táxons? 
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 e. De maneira geral, quais são os tipos de eventos que podem explicar a distribuição disjunta de táxons? 

Utilizando como base as reconstruções de áreas ancestrais obtidas com o S-DIVA, responda: no caso específico das 

quatro espécies mencionadas no item "d", como explicar as suas disjunções? A distribuição dessas espécies corrobora 

alguma hipótese existente sobre a existência de uma rota específica por onde as espécies teriam expandido sua 

distribuição? 

 

 

 

 

 f. As espécies Sinningia incarnata e S. sceptrum formam um clado (node 114 na figura do S-DIVA). Observe 

a distribuição dessas espécies na Figura 4D. Utilizando como base as reconstruções de áreas ancestrais obtidas com o 

S-DIVA, responda: como explicar o padrão atual de distribuição dessas espécies? 

 

 

 

 g. Finalmente, verifique se os padrões gerais obtidos em Sinningieae estão condizentes ou conflitivos com os 

seguintes modelos e hipóteses biogeográficos vigentes: 

1. existem áreas de endemismo distintas ao longo da extensão N-S da Mata Atlântica. 

2. na Mata Atlântica, existe maior relação biogeográfica dos setores do Sudeste e Sul com as matas semideciduais 

adjacentes (de latitudes próximas) do que entre aqueles setores e o setor Nordeste. 

3. as relações florísticas/biogeográficas com regiões mais secas ou abertas do interior do Brasil se fazem notar mais 

nos táxons de baixa altitude (componente tropical da MA), enquanto as relações com os Andes aumentam com a 

altitude (componente temperado da MA). 

4. a maioria dos táxons dos campos de altitude (onde muitos representantes de Sinningieae ocorrem) inclusos no 

Domínio da Mata Atlântica parece ter chegado ali por migração via habitats favoráveis, e não por dispersão a longa 

distância recente. 

5. os padrões de endemismo e diversidade na flora dos campos de altitude do sudeste brasileiro denotam provável 

predomínio de especiação alopátrida (ou parapátrida), dirigida predominantemente por fatores climáticos. 

6. o modelo de “bomba evolutiva” frequentemente invocado para floras montanas (e.g., Morton 1972) pode se aplicar às 

espécies de Sinningieae e à flora de altitude da MA. 
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Figura 1. Sinningia elatior (Kunth) Chautems. (A) Tubérculo e base do caule; (B) Inflorescência; (C) Flor; (D) 

Anteras coniventes em vista frontal; (E) Cálice aberto com nectário e ovário; (F) Esquema da disposição das 

glândulas nectaríferas; (G) Cápsula. Extraído de Chautems (1993). 
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Figura 2. Hipótese de relações filogenéticas da tribo Sinningieae resultante da análise simultânea de sequências 

plastidias e nucleares. Os valores de bootstrap estão representados abaixo dos ramos. Os nomes dos principais 

clados estão indicados, bem como dos dois subclados que serão analisados em detalhe na análise com o S-DIVA. 
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Figura 3. Áreas biogeográficas utilizadas para delimitar as distribuições das espécies de Sinningieae nas Américas 

do Sul e Central. Os valores abaixo das letras representam o total de espécies que ocorre em cada área 

biogeográfica e quantas dessas são endêmicas a essa área (entre parênteses). A delimitação das áreas foi 

realizada a partir de Gentry (1982), IBGE (1993) e Pennington et al. (2000). 

 

A = Pampas (Sul do Brasil e Uruguai) 

B = Porção Sul da Mata Atlântica brasileira (ao Sul do Trópico de Capricórnio) 

C = Porção Norte da Mata Atlântica brasileira (ao Norte do Trópico de Capricórnio) 

D = região do Paraná 

E = região do Cerrado 

F = Região do São Francisco 

G = Chaco 

H = porção sul dos Andes 

I = porção norte dos Andes 

J = Amazônia 

K = norte da Colômbia, Venezuela e Escudo Guiano 

L = América Central e sul do México 
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Figura 4. Distribuição de espécies amplamente distribuídas. (A) Sinningia warmingii; (B) S. sellowii; (C) S. elatior; 

(D) S. incarnata (círculos) e S. sceptrum (triângulos). 

 

 

 

 

 

 

 

 


